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1. What is Windows? 

 
AA  wwiinnddooww  iiss  tthhee  rreeccttaanngguullaarr  ppoorrttiioonn  ooff  aa  ddeesskkttoopp  tthhaatt  ddiissppllaayyss  aann  ooppeenn  pprrooggrraamm  oorr  tthhee  

ccoonntteennttss  ooff  aa  ffoollddeerr  oorr  ddiisskk..    YYoouu  ccaann  ooppeenn  mmuullttiippllee  wwiinnddoowwss  aatt  aa  ttiimmee..    TThhiiss  aabbiilliittyy  

((ooppeenniinngg  mmoorree  tthhaann  oonnee  pprrooggrraamm  aatt  aa  ttiimmee..))  iiss  oonnee  ooff  tthhee  ddiissttiinngguuiisshhiinngg  ffeeaattuurreess  ooff  

wwiinnddoowwss..    WWiinnddoowwss  iiss  aa  ssiinnggllee  uusseerr,,  mmuullttiittaasskkiinngg  ooppeerraattiinngg  ssyysstteemm..    UUnnlliikkee  DDOOSS,,  tthhee  

WWiinnddoowwss  ooppeerraattiinngg  ssyysstteemm  pprroovviiddeess  aa  ggrraapphhiiccaall  uusseerr  iinntteerrffaaccee..  

  

TThhee  llaatteesstt  vveerrssiioonn  ooff  wwiinnddoowwss  iiss  WWiinnddoowwss  XXPP..    EEaarrlliieerr  vveerrssiioonnss  wweerree  WWiinnddoowwss  22000000,,  

WWiinnddoowwss  9988,,  eettcc..    IInn  tthhiiss  ttrraaiinniinngg  mmaannuuaall,,  wwee  sshhaallll  sseeee  hhooww  ttoo  uussee  WWiinnddoowwss  XXPP..  

 

2. Benefits of Windows 

 

The main benefits of MS-Windows over that of MS-DOS are: 

 No need of memorizing commands and switches. 

 No typing required.  You simply click on menus, dialog boxes, option buttons, list 

boxes, etc. 

 The availability of many programs designed to run under windows. 

 The possibility of sharing information between windows program is high. 

 High support for communication. 

 Use of many programs simultaneously. 

 High support for long file name, enabling file organization easier. 

 

3. Components of windows 

 

Desktop 

 

When you start Windows
 
XP, the large area you see is called the Desktop, on which icons, 

windows and applications are displayed.  Think of the Desktop as your personal workspace. 
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Icons:  Are small pictures representing a program, disk drive, file, folder, application or other 

item. 

Folder:  Contain programs, files, or other folder that are grouped together for easy access. 

Menu:  list of commands. 

 

Mouse:  A mouse is a pointing device that is used in windows.  It is a hand held device that 

controls the movement of a pointer on your screen.  The object that moves around the screen 

as the mouse is moved is called a mouse pointer. 

 

There are usually two buttons on the mouse: Left and Right button.  The terms used while 

using mouse are: 

 

Pointing:  Positioning the mouse cursor over an item or an area you want. 

Clicking:  Positioning and pressing the left mouse button once. 

Double Clicking:  Clicking the mouse button twice quickly over an object.   

Dragging: Positioning the mouse cursor on an object, holding the mouse button down and 

moving the cursor to a desired place before releasing the button. Dragging helps to 

move an object. Moving objects on your screen is a lot like moving object around 

your desk. For example, clicking and dragging on an icon is a lot like physically 

pacing up a pen or some other object with hand and dragging the pen in a new 

location.  

 

You also drag to select text, such as word in a document or the name of a file. To select a text 

you first insert your cursor (a blinking vertical line) where you want to start the selection by 

clicking. Then hold down the left mouse button, drag to the place where you want to end the 

selection, and release the mouse button.  

 

Remark:  the shape of the mouse cursor changes to signify or indicate different things. These 

are:  

Vertical resize: To resize top or bottom boundary of window or an object. 
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Horizontal resize:  To resize the left or fight boundary of window or an object.  

 

Diagonal resize:  To resize the diagonal corners of a window or and object. 

 

Move:  When ever you have selected on object for moving, your pointer would turn into this 

shape. 

 

Normal Select:  Whenever you normally point the mouse pointer at any object or icon, 

scroll bar, or menu the mouse pointer would turn into this shape. 

 

Help Select: Whenever you click on what is this? Form the help menu or press shift + F1 on 

the key board, the mouse pointer would turn in to this shape. Once you get this shape, simply 

click on the icon for which you want description.  

 

Working in back ground: Whenever you execute a command, which takes, a couple, 

windows would display this shape. This means that the window is processing your request in 

the background.  

 

Busy: When ever windows is trying to load some information in to the computer memory, or 

is busy trying to open or save a file, this mouse pointer would be displayed.  

 

Text select: Whenever and wherever you can work on some text or some typed input is 

required from the user, this mouse pointer would be displayed. 
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Disk Drives: 

Are data reading and writing device which are used to read the data stored on the CD (disk) 

and transfer to the primary memory for farther process or to write data on the DC (disk). We 

use disk drive letter to specify drives.  

 

For: 

I. Micro floppy disk, we use  A: drive  

II. Mini floppy disk, we use B: drive 

III. Hard disk, we use C: drive  

IV. CD's, we use D: drive  

 

4. Working with Windows Environment  

 

When you switched on your computer, windows will load it self in your computers memory.  

Depending on how your computer is setup, the first time you start windows, various items 

appear on the desktop. Here are the elements you see on the desktop of Windows 
XP 

when you 

start windows. 

 

The Start button and Taskbar  

 

The taskbar is located at the bottom of your screen. It is a bar and contains the Start button 

(allows you to quickly start a program or to find a file), Tool bar, Clock and other features. At 

the far-right corner of the task bar, you see the system clock. Point your cursor (double click 

on it) to see the date and time. When you open a program, document or window, a button 

appears on the taskbar. You can use this button to quickly switch between the windows you 

have opened by clicking its taskbar button. When you click the start button, you see a menu 

that contains every thing you need to begin windows.  
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My Computer  

 

It is located at the upper left corner on the Desktop. You can use My Computer to quickly and 

easily see every thing on your computer. In side My Computer, you can see a list of all of the 

disk drives on your computer.  

 

Recycle Bin  

 

The Recycle Bin is a folder where the windows stores deleted files. You can use the Recycle 

Bin to retrieve files you deleted in error, or empty the Recycle Bin to create more disk space.  

 

5. Elements of windows  

 

Most windows have certain elements in common which looks like as the fig. Below.  

 

Control Menu: When clicked on, this box drops a system menu. The menu contains the 

Move, Resize, Maximize, Minimize, Restore and Close buttons. It is also called the system 

icon.  

 

Title Bar: Contains the name of application, program or currently opened document. It is 

used to move a window by holding down the left mouse button and move it to the desired 

place. It is also used to maximize or restore a window (double click on it). 

 

Menu bar: is an area with a series of menu names. Clicking in this menu name drops a menu 

that contains a number of commands from which we can select.  

 

Minimize, Maximize and Close Buttons: They are located in the top, right-hand corner of 

ever window. When you click on the minimize button, the window is reduced to an icon on 

the taskbar. The Maximize Button is changed to Restore button, which returns the window to 

its original state.  
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Scrolling Arrows and Bars: Very often, a window you open can't display everything that is 

in it. If so, the window will have a scrolling arrow and bar, either a vertical one along the right 

side or a horizontal one across the bottom, or both. If a window doesn't have anything hidden 

that you can't see, you will not see any scroll bars. To see more of what a window has, click 

on the scroll arrow and hold the mouse button down, or drag the scroll bars to scroll more 

swiftly.  
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The Status bare: There is also a status bar at the bottom if the window that gives you 

information about what is in windows, If you are not viewing the status bar choose status bar 

from view menu. The status bar has hider features that show you what menus will do if you 

choose an option from them and displays in information explaining what the mysterious icons 

are as you move the mouse pointer over them.   

 

6. Starting and Quitting Programs  

 

Starting a Program  

 

 To start a Program:  

 

1. Click the Start button, and then point to All Programs  

2. If the program you want is not on the menu, point on the folder that 

contains the program.  

3. Double-click the program.  

 

Remark: If the program you want to start doesn't appear on the All Programs menu or one of 

its submenus, point to Search on the start menu and then click Files and Folders. Use the 

Search dialog box to type the program you want and click Search. From the search results 

dialog box, double click the program you want to open.    

 

Alternative Method: Starting a program by using the Run command. 

 

1. Click the Start button, and then click Run.  

2. In the Open box, type the location and name of the program you want to start.  If 

you don't remember the location or name of the program file, click Browse and 

from the programs that appear, double-click on the program you want to open.  

 

 



 

MS-Windows XP Training Manual 
 

Prepared by: Tewelgn Kebede 8 

 

 

Starting the Word Pad  
 

 

Windows includes a text editor, Word pad, which you can use to create and modify 

documents.  

 

 To start Word pad:  

i. Click the Start button  

ii. Point to All Programs 

iii. Point to Accessories  

iv. Click on Word pad  

 

Starting Paint  

 

Windows includes a program, paint that enables you to create, modify or view pictures.  

 

 To start Paint:  

1) Click the Start button 

2) Point to All Programs  

3) Point to accessories  

4) Click Paint  

 

Starting Calculator  

 

Windows includes a program, called Calculator that enables you to perform simple 

calculations. You can use Calculator in Standard View to do simple calculations or use it in 

Scientific View to do advanced scientific and statistical calculations. To start Calculator, 

click Calculator from Accessories in the All Programs option.  
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Switching between Windows  

 

You can switch to another opened programs or a window by clicking its button on the 

Taskbar or click on anywhere inside the window (if not minimizes). Switching doesn't close 

the program window you were working in; it just changes the view on your screen.  

 

Cascading and Tiling Windows  

 

Cascading means arranging windows one over the other, while Tiling means arranging 

windows side by side. Use the right mouse button to click on the empty space of Taskbar and 

then click Cascade Windows (arrange windows on over the other) and Tile Windows 

horizontally or vertically (To arrange windows side by side) from the pop-op menu, as you 

want.  

 

Menu Conventions  

 

Commands or sometimes characteristics are listed on menus. Most applications have their 

own menus, which are listed on the menu bar along the top of the application window. To 

choose commands from a menu, click on the menu, move the mouse pointer on the menu item 

and click on the item you want. The following menu conventions are used in windows  

 

a) A Check Mark () to the left of a command: shows the command is in effect at the 

Current time.  

b) A Triangle ( ) to the right of a command: shows you that if that command is 

chosen, another files or folders are placed. 

c) Dimmed or not visible menu: The command cannot be used at the current condition. 

d) A key combination to the right of a command: shows the shortcut for the chosen 

command by suing the keyboard. 

e) An ellipse (...) following a command: A dialog box appears when the command is 

chosen.  
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Dialog Boxes  

 

Dialog boxes are specialized windows, which appears when you need to supply additional 

information to complete a task. The elements of dialog boxes are:   

 

Combo Boxes (Drop-Down List Boxes):  provides features of a text box and list box 

because you can type right into it or select from a list of choices. To choose an item in combo 

box, click on the down arrow, and from the choices that appear click on your choices. 

 

Text Boxes: Boxes in which information is typed against on insertion point.  

 

Check Boxes: Are used to set ON or OFF. You can check more then one check box in a 

group.  
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Option Buttons: Option button are some times referred as radio buttons. Only one option 

button in a group can be selected. Click on the one you want to choose it.  

 

Command and buttons: Buttons to choose a command to initiate and action. The action the 

button will perform will indicate on the button itself. The action can either be indicated by 

graphics as on a toolbar or by text as on the OK, Cancel, Quit Open and Help 

button found in many dialog boxes. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tabs: Some dialog boxes have multiple sections and categories. Tabs separate such section 

and only the option on currently highlighted tab can be viewed. When you select different 

tabs, the original tab move back and the new tab is brought in to foreground. To move 

between different tabs in a dialog box, click on the tab required.  
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Arranging the Icons on the Desktop  

 

As you work with windows, your screen can get cluttered very quickly. You can arrange the 

icons on your Desktop based on the date, time, the folder, and the shortcut was created or size 

or type of the folder or file.  

 

You can arrange icons on the Desktop by simply dragging and placing them where you want 

to place them.  

 

Or  

1. Right click on the blank area of the Desktop  

2. Click on the Arrange icons  by option 

3. Click on the desired type of arrangement  

 

Quitting an Opened Program  

 

 To close a program:  

1) Click on the Close (X) button from the top-right corner of the window, or  

2) Click File and then Click Exit or Close from the Control menu.  

 

If you are using multiple windows, and want to close all opened windows, hold the Shift key 

and then click the Close (X) button in the upper right corner of the title bar.  

 

Shutting Down Your Computer.  

 

To avoid damaging programs, always shutdown windows (the programs you opened) before 

you turn off your Computer. That way, you can also be sure of your work is saved.  
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7. Working with Files and Folders  

 

In widow, you store your work in folders just like you would in your office or at home.  

 

Both the Explorer and My computer objects allow you to look at your programs, files and 

folders stored on disk.  

 

The Explorer: Allow you to see the hierarchy of all folders on your computer. Windows 

explorer displays folders in the left hand-panda and the contents of the folder in the right 

hand-pane.  

 

 To open explorer and look at the hierarchy of folders: 

 

1. Right click on the Start button and click Explore from the pop-up 

menu.  

2. Click a folder on the left side of the window to display its contents on 

the right. Click the plus (+) sign to display more folders.  

 

Remark: To change the size of either side of the window, drag the bar that separates the two 

sides.  

 

My computer: My computer window displays a list of all the disk drives plus icons for the 

control panel folder, My Documents, Recycle Bin and My Network places. When you open 

the disk drive, you can see the files and folders that it contains folders, files, programs and 

other folders. 

 To see what is in your Computer:  

 

1) Click the Start button and click on My Computer.  

2) Double-click on the icon for the drive you want to look at. This displays the contents 

of the drive. To open the file or folder, or start a program, double click on it.  
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You can also open the My Computer, from the Windows Explorer. Open the Explorer and 

double click My Computer.  

 

7.1 Creating a New Folder  

 

Your documents and programs are stored in folders, which you can see in My Computer and 

Windows Explorer.  

 

 To create a new folder:  

 

1.  In my Computer or Explorer (Widows Explore) check the dialog box by 

opening Explorer from Start button), open the folder in which you want to create a 

new folder.  

2. On the File menu, point to New and the click Folder.  Or, right-click on the empty 

screen and from the pop-up menu point to New and click Folder.  The new folder 

appears with a temporary name. 

3.       Type a name for the new folder. 

 

 

 To change the name of a file or folder: 

 

1. In My computer or Explorer, click the file or folder you want to rename.  You do 

not need to open it. 

2. On the File menu, click Rename or right click on the file or folder to be renamed 

and click Rename. 

3. Type the new Name. 

 To open a file of folder: 

1. Double click the drive that contains the file from my Computer or Explorer. 

2. Double-click on the desired file or folder. 

 



SNNPR Capacity Building Bureau 

Department of Information Communication Technology                                      15 

 

 

 To select the Whole files or folders: 

1. Click the first icon. 

2. Hold down the Shift key while you click the last icon to be selected. 

 

 To select only some files or folders: 

Hold down the CTRL key while clicking each one. 

 

7.2 Copying and Moving Files and Folders 

 

Copying means duplicating (producing) a copy of files while moving a file is removing it 

from its original position. 

 

 To copy a file or folder: 

1)  Select the file or folder to be copied 

2) On the Edit menu or standard toolbar click Copy.  Or right click on the file or folder 

to be copied and click Copy from the pop-up menu. 

3) Open the folder or disk where you want to put the copy. 

4) On the Edit menu or standard toolbar or from the pop-up menu click Paste. 

 

Note:  Use Ctrl + Left drag to force a copy. 

 

Remark: To move a file or folder, follow the same procedure as copying except that instead 

of clicking copy from the edit menu or standard tool bar to copy a file or folder, 

click cut to move.  

 

Note: - Use the left mouse button to drag the object from one folder to another on the same 

drive.  

           - Use Shift + Left drag to force move. 
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Copying a File to a Floppy Disk  

 

 To copy a file or folder to a floppy disk  

1) Insert the disk into the floppy disk drive.  

2) In My Computer, or Explorer, click the file you want to copy.  

3) On the File menu, point of Send to and then click 3 ½ Floppy.  

   Or - right click on the file to be copied.   

        - Point to Send to and then click 3 ½ Floppy.  

 

 To make a copy of a disk:  

1. Click the icon for the disk you want to copy.  

2. On the File menu, point to the Disk Copy and click Copy Disk.  

3. In Copy From, click the drive you want to copy from.  

4. In Copy To, click the drive you want to Copy to. 

5. Click Start.   

 

7.3 Opening Files and Folders 

 

The act of accessing (reading or retrieving) files and folders you have stored in some disk 

storage is known as opening. After you have looked the file you want, you can double-click 

to open it.  

 

 To open a file of folder:  

1. From the Desktop, double click My Computer. 

2. Double - click the drive that contains the file or folder you want to open. 

3. Double -click the file or folder you wan to open.  
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7.4 Deleting Files and Folders  

 

Whenever you delete a file, it is temporarily moved to the Recycle Bin, on the Desktop. If 

you need the files you have deleted, you can restore the files. However, when you empty the 

Recycle Bin, all of the items in are permanently deleted from your computer.   

 

 To delete a file: 

1. Click on the file or folder you want to Delete 

2. On the File menu, click Delete.   

Or 

1. Right-Click on the file or folder you want to delete. 

2. From the pop-up menu, click Delete. 

 

Remark:  If you want to retrieve a file you have deleted, look in the Recycle Bin.  Your 

deleted files remain in the Recycle Bin until you empty it. 

 

 To delete files with out moving them to Recycle Bin: 

1. Select the file or folder to be deleted. 

2. Use the right moves button to click the selection. 

3. Hold down the Shift Key and click Delete or hold down the Shift key while pressing 

the Delete key if you are using the keyboard. 

 

 To retrieve deleted files: 

1. Double-click the Recycle-Bin icon 

2. Click on the fie you want to retrieve 

3. Click Restore all items. 

 

 To empty the Recycle Bin 

1. Double-click the Recycle Bin. 

2. Click Empty Recycle Bin. 
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7.5. Labeling and Formatting a Disk 

 

Labeling is used to give, change or display the volume label of a disk. 

 

 To label a disk: 

1. If the disk you want to label is a floppy disk, insert into its drive. 

2. Double-click My Computer icon 

3. Right click on the drive icon you want to label. 

4. Choose the Properties and click the General tab. 

5. On the Label text box, type the label. 

6. Click Ok. 

 

Formatting a Disk 

 

Formatting a disk means, preparing a disk for use.  Formatting a disk removes all information 

from the disk.  You cannot format a disk if there are files opened on that file.  

 

 To format a disk: 

 

1. If the disk you want to format is a floppy disk, insert it into its drive. 

2. In My Computer or in the right pane on Explorer, right-click the icon for the disk 

you want to format. 

3. On the File menu, Click Format. 

4. Click Start. 
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8.6 Using Help 

 

If you do not know how to do something, you can look it up in help. 

 

 To use help: 

1. Click the Start button. 

2. Click Help 

3. Click the Contents tab to browse through topics by category.  Click the Index tab 

to see a list of index entries that is either type the word you are looking for or 

scroll through the list.  Click the Find tab to search for words or phrases that may 

be contained in a Help topic. 

 

Getting Help in a Dialog box 

 

You can get Help on each item in a dialog box by clicking the question mark button in the 

title bar and them clicking the item.  If the dialog box doses not have the button, look for a 

Help button, or try pressing F1. 

 

Another way to get help is to use your mouse button to click an item, and then click What is 

This?  on the menu that appears. 



 

MS-Windows XP Training Manual 
 

Prepared by: Tewelgn Kebede 20 

 

 

9.   The Control Panel 

 

The control panel window contains numerous icons that allow you to control your system.  

The particular icons that you see on your own PC may be slightly different from computer to 

computer, due to the fact that you may have different hard ware installed. 

 

You can change all of your computer setting from adding program and fonts to customize 

your disk top in control panel. 

 

 To open control panel: 

1. Click Start 

2. Click Control Panel 

3. Click on Switch to Classic view, if it is not in Category View  

 

9.1. Date and Time 

 

In side your computer, there is a component called a real time clock (RTC).  This RTC and 

COMS battery ensure that the basic settings are lost when you switch off your computer.  

RTC stores the current time and date in your computer and passes on this information to put a 

date and time to correct operations.  The current Date, Time and Time Zone information can 

be set from the Date and Time icon with in the Control Panel. 

 

 To Change the Date and Time: 

1. Open Date and Time from the Control Panel. 

2. Click on the Month-roll-down to change the Month. 

3. Click on the Year button to change the year. 

4. Click on any of the Date to change the Date. 

5. Click on the Time button.  

6. Click Apply and Ok. 
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Time Zone:  This option determines which time zone you are in.   Especially for Laptop users 

who zip across many countries (and time zone frequently). 

 

 To change the time zone: 

1. Select Date and Time form control panel 

2. Click Time Zone folio 

3. Choose the Time zone you want to change by scrolling up and down.  

4. Click Apply, Ok 

 

9.2. Changing The Desktop's Pattern or Wall Paper 

 

Display:  Is used to modify Desktop background, Screen savers, Menu appearances etc. 

Background:  Desktop wallpapers decorate and add more colors fun to your life. 

 

 To change background: 

1. Double-click Display from Control panel 

2. Click on Back ground folio tap. 

3. Click on the Wallpaper or HTML from the list that you want. 

4. Click Apply, Ok. 

 

Screen Saver:  Is a moving image or pattern that appears on your monitor when you have left 

your computer idle for specified limits.  Screen saver serves four main functions: 

 

1. Most of them are interesting and provide fun and entertainment. 

2. When the save static image stays on screen for a long periods of time, it can burn the 

delicate phosphors on the inside surface of the picture of your monitor.  This can live 

the permanent ghost of the image on the screen, there by damaging monitor. 

3. Many newer computer have built power saving option built into them (e.g. EPA 

energy Star, VESA, etc.), which powers the monitor as soon as the screen savers come 

in to effect, there by saving on your electricity bills. 
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4. The screen saver has security feature that is once the screen saver is activated, it 

requires the user typing in the correct pass word before you can resume working.  This 

makes sure that no body peeps and messes with your computer file while you are 

away from your desk. 

 

 To change the Screen Saver: 

1. Double-click Display from the Control panel. 

2. Click Screen saver tab. 

3. Click the screen saver roll-down list and choose the screen saver that you want 

to apply. 

4. Click Setting to change the Setting. 

5. Click on Preview to preview the screen saver before applying it. 

6. Click on Wait comb box to increase or decrease the time after which the screen 

saver would appear. 

7. Click Apply, Ok. 

 

9.3. Fonts 

 

Like having different hand writings available on your computer, fonts are type faces that you 

can use pop up your work and change the appearance of characters on your screen and on the 

printer-paper. 

 

 To change fonts: 

1. Double click Fonts from Control Panel.  A list of all available fonts would be 

displayed. 

2. Double -Click the icon for the font to see a sample of font. 
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9.4. Mouse 

 

You can control the mouse pointer speed, shape, button configuration, Double-click speed, 

etc. 

 

 Button configuration: 

1. Double-click Mouse from Control panel 

2. Click on Button Folio tab 

3. Click on right handed radio button of the button configuration, to convert your left 

Mouse button into right mouse button and vise versa. 

4. Drag the slider to increase the clicking speed of the mouse.  

5. Click Apply, Ok. 

 

 Pointing configuration: 

1. Double Click Mouse form Control panel 

2. Click on pointer folio 

3. Click on the Combo Box to select scheme. 

4. Drag the scroll bar to customize or click Browse... to choose another scheme 

5. Click Apply, Ok 

 

 Motion configuration: 

1. Click Mouse from Control panel 

2. Click on Motion folio 

3. Drag the slider on the adjacent how fast you pointer moves on the acceleration 

frame, you can click on the option (None Low Medium High) to make them look 

ling or short. 

4. Click Apply, Ok 
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9.5. Multimedia 

 

As the name suggests, it is a combination of many mediums:  Sound, Static pictures, Movie 

clips, Animation, Text, etc.  To use multi-media, you must have the hardware’s: CD-ROM 

drive, Sound card, Speaker and Microphones. 

 

 To change multimedia: 

1. Double click Multimedia from control panel 

2. Choose any folio tab as your requirement to get the subsequent dialog box in this case 

click video 

3. Click on window radio button if you want your screen to appear in window format or 

click on the full screen radio button to get a full screen picture 

4. Click on roll down list (Show video on the frame) to choose the type of window 

screen that you want. 

5. Click Apply, Ok 

 

9.6. Regional Setting 

 

Are settings like Language, Number, Formatting, Currency, Date and Time format. 

 

Steps: 

1. Double click Regional setting from control panel 

2. Click on General folio. 

3. Drag the scroll bar to select your location (Regional Settings).  Choosing the Regional 

Setting automatically changes settings on the Number, Currency, Time and Date 

tabs. 

4. Click on Apply, Ok. 
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9.7 Installing Programs from CDs’ 

 

1. Insert the CD into its drive. If the CD is bootable CD, it starts 

automatically. 

2. If the CD is not bootable, Double-Click My Computer, and Open 

the CD drive you want. 

3. Follow the screen that appears. 


